SIEMENS

Preface

SIMATIC NET

Overview of the Steps

. “PROJECT ETHERNET”
NCM S7 for Industrial Ethernet  The s7 sample Project

Primer —
Communication on the
SEND/RECEIVE Interface...
...Between S7 Stations
...Between S7 and S5 Stations
References

11/2002

C79000-G8976—-C116

Release 03

pd



Classification of Safety-Related Notices

> B P

This manual contains notices which you should observe to ensure your own perso-
nal safety, as well as to protect the product and connected equipment. These noti-
ces are highlighted in the manual by a warning triangle and are marked as follows

according to the level of danger:

Danger

indicates that death or severe personal injury will result if proper precautions are
not taken.

Warning

indicates that death or severe personal injury can result if proper precautions are
not taken.

Caution

with warning triangle indicates that minor personal injury can result if proper
precautions are not taken.

Caution

without warning triangle indicates that damage to property can result if proper
precautions are not taken.

Notice

indicates that an undesirable result or status can result if the relevant notice is
ignored.

Note

highlights important information on the product, using the product, or part of the
documentation that is of particular importance and that will be of benefit to the
user.
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Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of
SIEMENS AG.

Third parties using for their own purposes any other names in this document which
refer to trademarks might infringe upon the rights of the trademark owners.

Safety Instructions Regarding your Product:
Before you use the product described here, read the safety instructions below tho-
roughly.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment.
Qualified persons are defined as persons who are authorized to commission, to
ground, and to tag circuits, equipment, and systems in accordance with establis-
hed safety practices and standards.

Correct Usage of Hardware Products
Note the following:

ii Warning
This device and its components may only be used for the applications described in
the catalog or the technical description, and only in connection with devices or
components from other manufacturers which have been approved or
recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set
up, and installed correctly, and operated and maintained as recommended.

Before you use the supplied sample programs or programs you have written
yourself, make certain that no injury to persons nor damage to equipment can
result in your plant or process.

EU Directive: Do not start up until you have established that the machine on which
you intend to run this component complies with the directive 89/392/EEC.

Correct Usage of Software Products
Note the following:

ii Warning
This software may only be used for the applications described in the catalog or the
technical description, and only in connection with software products, devices, or
components from other manufacturers which have been approved or
recommended by Siemens.

Before you use the supplied sample programs or programs you have written
yourself, make certain that no injury to persons nor damage to equipment can
result in your plant or process.
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Prior to Startup
Prior to startup, note the following:

Caution

Prior to startup, note the information and follow the instructions in the latest
documentation. You will find the ordering data for this documentation in the
relevant catalogs or contact your local Siemens office.

Copyright © Siemens AG 2001 — 2002 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for
damages. All rights, including rights created by patent grant or registration of
a utility model or design, are reserved.

Siemens AG
Automation and Drives

Postfach 4848, D-90327 Nuernberg

Disclaimer of Liability

We have checked the contents of this manual for agreement with the hard-
ware and software described. Since deviations cannot be precluded entirely,
we cannot guarantee full agreement. However, the data in this manual are
reviewed regularly and any necessary corrections included in subsequent
editions. Suggestions for improvement are welcomed.

Technical data subject to change.

Siemens Aktiengesellschaft
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Preface

Aims You want to install our SIMATIC S7 CPs in your system and make
optimum use of them.

How to Achieve This primer will help you to become familiar with handling NCM S7 for

Your Aims Industrial Ethernet, the configuration tool for S7 CPs. Based on the
configuration and program examples supplied with NCM, we introduce
you to the typical steps required to make optimum use of NCM S7 for
Industrial Ethernet with your SIMATIC S7 CPs.

Aims of the Primer... ...how to achieve the aims

You can learn how to use the ...by working through the steps

product effectively in a short described and using the supplied

time... example on a suitable system
configuration.

You can learn how to use the ...by using the description to

product extremely effectively support you when you first

taking somewhat more time... | configure and program an
application of your own.

Requirements You should be familiar with the basics of STEP 7, in other words you
should know the following:

e How to work with STEP 7
¢ Which functions STEP 7 provides for managing hardware and software
¢ How to handle projects

Audience This primer is intended for installation personnel and STEP 7
programmers as well as for service personnel.

Scope of the This primer applies to Version V5.2 and higher of the NCM S7

Manual configuration software and to Version 5.0 and higher of the STEP 7
software.

Further For further information about STEP 7 documentation and the product,

Information... please refer to the accompanying manual “NCM S7 for Industrial
Ethernet”.

For further information about installing the NCM S7 for Industrial
Ethernet software, please refer to the readme file.

SIMATIC NET NCM S7 for Industrial Ethernet
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Preface

Note

Please note that the NCM S7 for Industrial Ethernet product information bulletin
may contain further information about the sample programs described in this
primer.

Conventions The following conventions are used in the primer:

e References to other manuals and documentation are indicated by
numbers is slashes /.../. These numbers refer to the titles of manuals
listed in the Appendix.

e Actions you are required to perform are indicated by the symbol " »~ "

4
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1 Overview of the Steps

Based on the sample configuration and the sample program “PROJECT ETHERNET”, the
Primer will guide you through the following steps in the next chapters:

Chapter 2
“PROJECT ETHERNET”

1. Create/open your project

It is advisable to create all the system data “offline”.
The data can then be changed, saved and

downloaded at any time. The basis for this is the
STEP 7 project PROJECT ETHERNET.

2. Configure and network your hardware

You specify the components of your system.
Base your selection on the configuration
explained Chapters. 3 and 4.

Chapter 3 Chapter 4
ISO S7<—>S7 ISO S7<—>S5

3. Configure communications service

You set up ISO transport
connections.

4. Write your user program

You convert your control task to an S7 user

program. You can use, for example, the STL
notation.

5. Startup/diagnostics

If you encounter problems, you can
investigate the S7 stations with the
online tools of STEP 7/STL and

NCM diagnostics.

To achieve success quickly...

If your system configuration corresponds to the configuration selected for the sample, you can
download the sample data directly to the S7 stations in steps 2, 3 and 4!

You will, however, learn more by working through
the steps as outlined in this primer. ‘TR ‘

SIMATIC NET NCM S7 for Industrial Ethernet
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2 “PROJECT ETHERNET”
STEP 7 Samples for Ethernet CPs

This chapter explains how you can use the “PROJECT ETHERNET”
with the configurations and programs for the communications samples.

How the chapter will help you:

¢ You will get to know how to create a project with CPs

¢ You will get to know all the steps involved in configuration

Requirements:

A working knowledge of STEP 7, experience with STL, a
basic knowledge of PLCs.

If you require detailed information about the other
functions of the configuration software, please refer to
the corresponding manuals. This chapter also contains
references to specific manuals.

Contents:

— Create/open your project 9
— Configure and network your hardware 12

SIMATIC NET NCM S7 for Industrial Ethernet
8 C79000-G8976—-C116-03



“PROJECT ETHERNET”

1. Create/open your

| 2. Configure and network your hardware \ User programs and an image of the

S7 stations are managed in the
STEP 7 project.

After installation of the NCM S7 optional software, the sample project is located in the project
folder of STEP 7, for example in the folder C\SIEMENS\STEP7\EXAMPLES\EXIE.

If you want to use the project in the S7 folder, follow the steps outlined below:
»~ Start the SIMATIC Manager.

»” Open the supplied sample project PROJECT ETHERNET with File » Open » Project....

K SIMATIC Manager - [PROJECT-ETHERNET -- D:\Siemens\Step7\Exal From the sample program
£p File Edit Inset PLC Wiew Options ‘window Help displayed here, you move
2%e el El I':'_El ENEE 2 on to the steps described

..... in the following sections.

A

i L o
SIMATIC 400-Station(2] SIMATIC SIMATIC SIMATIC SIMATIC 55(1)
-l SIMATIC 400-Station[3] 400-5tation(1] 400-5tation[2) 400-5tation(3)
SIMATIC S5(2] MPI-Hetz(1] Ethemet [1]

Prezz F1 to get Help.

| | |
The sample project contains an Ethernet subnet. If you want to . ore infor-
create a new or further Ethernet subnet or a different object,

. P
mation...
- Manual
V” Select the function Insert » ... » ... 13/
Chapter 2

SIMATIC NET NCM S7 for Industrial Ethernet
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“PROJECT ETHERNET”

If you want to create a working version of the ETHERNET sample project...

»~ ...Use the menu command File » Save As to create a copy of the sample project in any
folder you wish.

Device configuration

The following table shows the configurations in the individual stations. This will also indicate
how much of the sample you can use directly and the extent to which you will have to adapt the

sample.
Station CP Type MAC Address Communicate Description
s with Station

SIMATIC 400 | CP 443-1 | 08.00.06.01.00.00 | SIMATIC 400 | Communication via the

station(1) station(2) SEND/RECEIVE interface with the
CP 443-1.
Data are transmitted in both direc-
tions. The FCs AG_SEND and
AG_RECV are used.

SIMATIC 400 | CP 443-1 | 08.00.06.01.00.01 | SIMATIC 400

station(2) station(1)

SIMATIC 400 | CP 443-1 | 08.00.06.01.00.03 | SIMATIC S5 Communication via the

station(3) station(1) SEND/RECEIVE interface with the
CP 443-1.
The user program is adapted to the
program sample of the CP 1430 TF
(see /14)).
Data are sent from the SIMATIC 400
station(3) to the SIMATIC S5 station.

SIMATIC CP 1430 08.00.06.01.00.02 | SIMATIC 400

S5(2) TF station(3)

10
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“PROJECT ETHERNET”

You have already created a configuration

If you have already created a configuration and simply want to use the sample programs for
your CPU, follow the steps outlined below:

»~ Copy the sample programs (container with S7 programs) of the station from the sample
project to the CPU of your existing project. Make sure that blocks do not overlap.

»~ Make sure that the hardware configuration and networking and the configured connections
are adapted according to the descriptions below.

Summary of step 1 “Creating the Project”:
You have created a STEP 7 project
— in which you can configure your system

— and in which you can create and save your user programs.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03 11



“PROJECT ETHERNET”

[ 1. Create /open your project P~

Which components does the system
include?

2. Configure and network your hardware

* How are the components attached to
the network?

When completed, you will have downloaded
the hardware configuration to the stations.

If you start with the existing sample configuration, you ‘TIPS |
should get an overview of it before you download the ' Page 2-8 deals with the topic |
configuration to the PLC. STEP 7 provides you with _‘Downloading”

convenient methods of obtaining an overview. You can
do the following:

L —

¢ Display the configuration in HW Config For more infor- Manual

¢ Display a station overview mation... 3l

¢ Display the networking of the stations graphically with Chapter 2
NetPro.

»” Double-click the object “Ethernet(1)” in your project in the SIMATIC Manager. This opens the
NetPro view for your project. :

E‘.!_%NelPlu - [PROJECT-ETHERNET [Network] -- D:\Siemens\Step7\Examples\Exie]
Pﬁgﬂetwnrk Edit Inset PLC Wiew Options Window Help

@[ (% &| e dlal 8 9|9 Bl K|

Ethernet (1) 1 =
Industrial Ethernet

MP-Metz(1)
WP
SIMA nterface |S\MAT|C 400-Station(2}) |S|MAT\C 400-Station(3) @ SIMATIC S5(1) @ SIMATIC
r””” Type: Industrial Ethermet cer r””H e ler
L Address: 08.00.06.01.00.00 1 = m
m m |
2 2 2
4] | _’l_l
Local ID Partner ID Partrer Active connection partner Subnet -~
007 A020 e C 400-5 &) ICPU4T4-1(1) 50 fransport connection K

From this display, you can start all the steps required for hardware and connection
configuration.

As shown in the illustration,
¢ the connection table for the selected CPU is displayed in the lower part of the screen;

¢ information about the network attachment is displayed if you point to the symbol for the
interface of the node with the mouse pointer.

SIMATIC NET NCM S7 for Industrial Ethernet
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“PROJECT ETHERNET”

From the information relating to the network attachments, you can recognize the following
situation:

The CP 443-1 has the configured MAC address (node). The CPU is shown with an MPI
address. You require this MPI addresse, for example, when you want to run diagnostic functions
on the CP via the MPI attachment of the CPU with NCM Ethernet Diagnostics.

If you want to modify the network address... For more

information...
... you can do this in the Properties dialog of the Ethernet N Manual
node. You can display this dialog by double-clicking the 12/
network node in the NetPro view. An address
modification may, for example, be necessary when the Chapter
configured Ethernet address is already being used in 2.24
your network by another station.

Checking the configuration in HW Config — here based on the example of the
SIMATIC 400 station(1)

»~ Select the station or the CPU in the SIMATIC 400 station(1) in the NetPro view; then select

Edit » Open Object. You will see the hardware configuration with an overview and a
detailed view.

E@HW Config - [SIMATIC 400-5tation[1) [Configuration] -- PROJECT-ETHERMET]

E“] Station  Edit Ingert PLC Miew Options Window Help _|ﬁ||5|
D[(5-[2 5] S| e sl [Ho] 8 el
[IGE :’ Profile | Standard =l
1 [@rsarios = PROFIBLIS DP
.39 PROFIBUS PA
3 CPU 414-2 DP(1) & SIMATIC 300
e OF
o T SIMATIC 400
T ERTERT ] SIMATIC PC Based Contiol 3007400
10) -8, SIMATIC PC Station
5 SIM _
4| | 3|
=] o e

Firmware | MPI address | | address | O address | Comment

GES7 414-Z4G03-0AB0

f<|
i CP 443101) iSOl i L E 21 i3 PROFIBUS-DP slaves for SIMATIC 57, ——
] sim DI/D0-5IMULATOR 0.3 0.3 _I 17, and C7 [distributed rack]

Preszs F1 to get Help. A

If you want to see the configuration of one of the displayed modules in detail,

»~ position the cursor on the module, for example the CP 443-1 and select Edit » Object
Properties.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03 13



“PROJECT ETHERNET”

Adapting the configuration in HW Config

If your hardware configuration does not match the configuration required for the sample, you
can now change the entries. You could, for example, make the following changes:

¢ Move modules to different slots.

— The configuration of the connections is retained.

— User programs may have to be adapted to a new module address.
e Work without a simulation module

To do this, delete the simulation module in slot 5.
¢ Use a different CP type

— The configuration of the connections is retained.

Outputting a station overview

Use the print functions of STEP 7 to create your system documentation. You can print out the
following:

e Entire station
e Selected module(s)

The printout for the CP you are using then appears as shown below:

SIMATIC PROJECT-ETHERNET/SIMATIC 400-Station(l) 09/13/2002 10:43:48
Rack 0, Slot 4
Short designation: CP 443-1
Order no.: 6GK7 443-1EX11-0XE0
Designation: CP 443-1(1)
Assigned CPU: CPU number 1 - Slot 3
Location
Station: SIMATIC 400-Station(l)
Width: 1
Network
Network type: Ind. Ethernet
Network name: Ethernet (1)
MAC address: 08.00.06.01.00.00
Addresses
Inputs
Start: 512
End: 0
System selection: - - -
Outputs
Start: - - -
End: - - -
System selection: - - -
Comment :
Required optional package: NCM S7 Industrial Ethernet

/\/\/\

SIMATIC NET NCM S7 for Industrial Ethernet
14 C79000-G8976-C116-03



“PROJECT ETHERNET”

Further information about networking the station

It is easy to obtain an overview of the existing network attachment configurations using the print

functions in NetPro.

The printout for a configured network appears as shown in the example below:

SIMATIC

D:ysiemensVSTEPT7VE02" Examp les EXIE

03/25/1998 16:06:52

Ethernet {1) contains the following network connections:

Mode Address Station;

08.00.06.01.00.00 SIMATIC
A00-Station( 1)

08.00.06.01.00.01 SIMATIC

400 Station(2)
SIMATIC S5(1)
SIMATIC
400-Station(3)

08.00.06.01.00.02
08.00.06.01.00.03

Module: Rack: Siot:
CP 443-1 BGR(1)0 4
CP 443-1 BGR(1)0 4

CP 443-1 BGR(1)0 4

MPI-N etz{1) contains no network connections.

\/\/\/

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03
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“PROJECT ETHERNET”

To download the hardware configuration to the PLC...
...follow the steps outlined below:
» Connect the PG to the MPI interface of the CPU using the MPI cable.

»~ Set the interface on your PG/PC for the required type of attachment. Select the PG/PC
interface in the Windows control panel to match the CPs available on your PG and to match
the bus attachment.

, To check which nodes are
' accessible over Ethernet, use the
. “Accessible Nodes” function.

5

-]

»~ Select the menu option PLC »Download...

STEP 7 then guides you through further dialog boxes to the

required result.
For more informa-

STEP 7 Help System

Manual
[T

Section
2.29

Summary of Step 2 “Configuring and Networking Your Hardware”:

You have now done the following:

1. Configured the S7 stations in the STEP 7 project

2. Assigned the S7 stations to the Ethernet subnet and assigned addresses
3. Downloaded the configuration to both S7 stations.

The stations are now ready for you to configure the communication connections and
download the user programs.

SIMATIC NET NCM S7 for Industrial Ethernet
16 C79000-G8976-C116-03



3 Communication on the SEND/RECEIVE

Interface between S7 Stations

The SEND/RECEIVE interface allows data exchange on configured

ISO transport connections, TCP connections, and 1ISO-on-TCP

connections.

This chapter explains the steps required during configuration and
programming to implement a simple communication task on ISO

transport connections.

How the chapter will help you:

You will learn about downloading and starting up.

programs.

You will get to know the steps involved in configuration.

You will become familiar with the SEND/RECEIVE call interface.

You can use the sample program as a basis for creating PLC

Requirements

working knowledge of PLCs.

specific manuals.

Contents
3.1 The task
3.2 System configuration
3.3 The example step by step
— Configuring 1SO transport connections

— Creating a user program
— Startup/diagnostics

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03

A working knowledge of STEP 7, experience with STL, a

If you require detailed information about the properties of

the type of communication introduced here or about other
functions provided by the configuration software, please
~J refer to the corresponding manuals. The preface of the

manuals provides you with an overview of the available
documentation. This chapter also contains references to

18
19
21
23

29
36




Communication on the SEND/RECEIVE Interface between S7 Stations

3.1 The Task

Sending and Receiving Data
The communication task illustrated by the sample program has deliberately been kept simple.
e A controller (SIMATIC 400 station 1) processes process data.

¢ |t communicates with a further device (SIMATIC 400 station 2), for example to delegate a
control job. The SIMATIC 400 station 2 returns data to station 1.

The following schematic illustrates how the program functions:

SIMATIC 400 station 1 SIMATIC 400 station 2

T L

Process data

Send job data (4 bytes) -

Accept job and execute
it

< Send response data (4 bytes)

Evaluate received
data

Time v Time

The jobs and responses in the example contain 4 bytes of user data.

SIMATIC NET NCM S7 for Industrial Ethernet
18 C79000-G8976-C116-03



Communication on the SEND/RECEIVE Interface between S7 Stations

3.2 System Configuration

Structure

The following system configuration is required for the supplied sample project (modifications /
alternatives are possible —> see following page):

SIMATIC 400 station 1
SIMATIC 400 station 2

) MPI interface
MPI interface

Ethernet

PG/PC with STEP 7

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03 19



Communication on the SEND/RECEIVE Interface between S7 Stations

Required Devices/Resources

You require the following components if you want to use the supplied example unmodified.

No. Type Order Number
Required
2 S7-400 programmable controllers with CPU 414-1 see Catalog ST 70
2 CP 443-1 6 GK 7443-1EX11-0XE0 D
2 Simulation modules DI/DO
Can be replaced by
Digital output module DO16xDC24V/2A 6ES7422-1BH10-0AA0
or by
Digital output module DO32xDC24V/0.5A 6ES7422-1BL10-0AA0
1 Transmision path see /11/ /12/
1 Programming device (PG/PC) with see Catalog ST 70

® STEP 7 software version V5.2 or higher installed

* Optional software NCM S7 for Ethernet version V5.2
or higher installed.

* MPI attachment

* As an option for the PG/PC mode on Ethernet: CP for
Ethernet attachment —>
diagnostics/installation/service

1) Newer versions of the module are normally compatible in terms of functionality; You can load

the configuration data of the sample project on your module without needing to make changes.
Please read the information in the manual of the CPs on the topic of compatibility and replacing
devices!

Alternatives:

You can adapt the sample configuration to suit your own situation. Possible modifications are
outlined below:

20

S7-300 instead of S7-400

Instead of S7-400 stations, you can also use S7-300 stations (for example with the
CP 343-1).

The appropriate adaptations must be made in HW Config and in the user program. You must
also use different FC types with an S7-300.

Using a different CPU type
Doing without simulation modules

This only requires slight modification in the user programs (no output to the simulation
module). It is then possible to monitor communication by displaying data blocks on the PG.

Using other input/output modules
This may mean that module addresses are changed.
Changing the order of the modules in the rack

This may mean that module addresses are changed with certain CPU types.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03




Communication on the SEND/RECEIVE Interface between S7 Stations

Notice

If you change the module address in the configuration, you must also adapt the
user program and the configured connection.

3.3 The Example Step by Step

This description is based on the created project and on the configured stations. The steps
“Create Project” and “Configuring and Networking Hardware” were explained in Chapter 2.

| 1. Create/open your project L~
[ 2. Configure and network your hardware V- Chapter 2
|
|
|

| 3. Configure I1SO transport connections

[ 4. Write your user program »  Chapter 3.3/ and pages following

| 5. Startup

To achieve success quickly...

If your system configuration corresponds to the configuration selected for the example, you can
download the sample data directly to the S7 stations in steps 3 and 4.

You will, however, learn more by working through TIP

the steps as outlined in this primer. ' Skip the functions that you
, already know.

: Chapter 2 deals with the topic of

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03 21



Communication on the SEND/RECEIVE Interface between S7 Stations

\ 1. Create/open your project

Set up communication

\ 2. Configure and network your hardware

connections for the CPUs.

3. Configure ISO transport connections

When completed, you will have
downloaded the connection

\ 4. Write your user program

configuration to the stations.

| 5. Startup

Communication on the SEND/RECEIVE interface uses
configured ISO connections . The next step is therefore

to download the connection list to the station.

First, however, you should get an overview of the sample configuration by:

Checking the connections in the connection table in NetPro

P

Manual
13/

Chapter 3

» Change back to the SIMATIC Manager and select the CPU in the required station.

HSIHATIC Manager - [PROJECT-ETHERNET -- D:\Siemens\5tep7\E xamples\E xie]

@Eile Edit Inzet FLC Yiew Options ‘Window Help

el = e A L N R N

e

| < Mo Fiter »

2 =] x|

=-E&p PROJECT-ETHERNET
- SIMATIC 400-5tation(1)
e P 14-1(1)
- CP 4431 BGR(1)
SIMATIC 400-5tation(2)
- SIMATIC 400-5tation(3)

Fress F1 to get Help.

S7-Programm(1]

Werbindungen

22

SIMATIC NET NCM S7 for Industrial Ethernet

C79000-G8976-C116-03



Communication on the SEND/RECEIVE Interface between S7 Stations

»~ Select the object “Connection” and then select Edit»
Open Object. The connection table is then displayed
with the entries for the selected station.

Pl Coecion

or

»” Change directly to the NetPro view by selecting the network.

E‘.!_%NelPlu - [PROJECT-ETHERNET [Network] -- D:ASiemens\Step7\Examples\E xie]

Pﬁgﬂetwnrk Edit Inset PLC “iew Options Window Help 18] x|
2@ (% g =|e| il 8 o]2] B x|
Ethernet (1) 1 =
Industrial Ethernet
MP-Metz( 1)
WP

Address: 08.00.06.01.00.00 =0
=]

ﬁmfmma o \Esrlur‘w?;c 400-Station(2) r””” |?Sr|£|:n?£c 400-Station(3) @ EMN‘C S501) @ SIMATIC
T 1 - ]
2

we connection partner

Here, you can select the

connection properties with a Here, you can select

double-click “Change Partners*
with a double-click.

From the display, the following situation is clear:

* One ISO transport connection is currently configured 'Note.. |
to the partner station SIMATIC 400 Station(2). ' ...By selecting the stations, you |

» can obtain an overview of all the

e Connection establishment is activated by | stations in the project and the |
SIMATIC 400 Station(1). ' configured connections. |

Further connections...
...You can configure further configurations to this or other partner stations in this overview.

V¥ To insert a new connection in the connection list, select the function Insert » Connection.

SIMATIC NET NCM S7 for Industrial Ethernet
C79000-G8976-C116-03 23



Communication on the SEND/RECEIVE Interface between S7 Stations

To check important connection parameters...

»~ Select the connection properties by double-clicking the connection in the connection table.

Properties - IS0 transport connection E 0001 is the ID that you
use
Dptions | Dverview | Status Information = in the user program on the
General | Addresses l/waw«/ SEND/RECEIVE interface
— Connection Endpoint — Block Parameters———— A020 is the ID for ISO
Local ID [hex: /\ transport connections.
MNarme:C_ {150+ erbindung-1 1—ID
viaCP:  [CP 4431150 - [R0/34] Wi1640200 —|LADDR

it | \/

¥ &ctive connection establishment

/ Cocel | Heb |

You can assign a name to _Il\_lr(])te on dthle bltoc{( P da:jrameterz: th

the connection reflecting its cor?nrgc?titgjnellg :ea:eqrueirsesdalgter v?/hen you
urpose in your system. ;

pup y y program the SEND/RECEIVE interface.

Page 31 has a similar sample call.

“Addresses” Tab

The information in the “Addresses” tab page for a connection between S7 stations within a
project does not normally need to be modified.

SIMATIC NET NCM S7 for Industrial Ethernet
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For further information about the status of the connection or the connection
configuration, open the “Overview” tab.

General | Addresses I Dvnarnics I Addresses I Dvnarnics I
Options Overview | Status Infarmation Overview Status Infarmation
Lonnections:
Local ID | Conn. name | R4S | Remote addressl Local TS.t‘-\F'l Fi :'l Remote TSAF" Operating mode: | Status
0001 020 1S04erbindung1 - 0/4  08-00-06-01-00-01 1501 1501  Send/Recv Ok
< | L2 [ i
2| Wisnley connections of &l BRI (R
Frirt Canfiguration | Eririt | Frirt Canfiguration | Eririt |
Cancel | Help | Cancel | Help |

If the character “I" appears in the “Local ID” field, this indicates further relevant information in
the “Status” field. Depending on the setting of the table header, this field may be hidden. You
can readjust the display with the horizontal arrow key.

In the situation shown here, the status is when the connection configuration is completed.

SIMATIC NET NCM S7 for Industrial Ethernet
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If you want to address another communication partner...

V~ ...select the “Change Partners” dialog with the Edit> Change Partners menu command or
by double-clickng the connection in the “Partner” column of the connection table.

E‘.!_%NelPlu - [PROJECT-ETHERNET [Network] -- D:\Siemens\Step 7AE xamples\Exie]

Pﬁgﬂetwnrk Edit Inset PLC Wiew Options ‘Window Help

(¥ (%) 8| e bl 8 9l Bl K|

Ethernet (1}
Industrial Ethernet

WPI-Netz(1)
WP

SIMATIC 400-Station(1)

|SMATIC 400-Station(2)

|SIMATIC 400-Station(3)

@ SIMATIC S5(1)
. 5] . TR [P . NG
B S i i

=] ] w0

-] o H

2 2 2
il |
Active connection partner

Change Connection Partner X

Partner
Station

Module:

[cPug1a1r) =1

Connection
’V Type:

|50 tansport connection

o ]

Cancel

Help

» If required, select a different connection partner in the “Station” field.
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To download the connection configuration to the PLC...
...follow the steps outlined below:

» If you have made changes in the connection configuration, save your changes with
Connection Table » Save.

V¥ Select the station in the connection table for which the Ethernet attachment exists.

V¥ Select the menu command PLC » Download.

1 During the download, you are as- |
' ked whether you want to copy '
, from RAM to ROM on the CP. If
' you want to save the data in non-
 volatile memory, answer with !

For more informa-

Manual
R )

»~ Attach the MPI to the SIMATIC 400 station (2).

»” Repeat step 2 “Configuring/networking your hardware” and step 3 “Configuring 1SO transport
connections” for the SIMATIC 400 station(2) if you want to make changes to the existing
configuration of the second station.

Summary of step 3 “Configuring ISO transport connections”:

You have now done the following:

— Configured an ISO transport connection between the two SIMATIC 400 stations
— Downloaded the connection configuration to the two SIMATIC 400 stations

The stations are now ready for data exchange on the SEND/RECEIVE interface.

SIMATIC NET NCM S7 for Industrial Ethernet
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\ 1. Create/open your project

\ 2. Configure and network your hardware

| 3. Configure 1SO transport connections

AR Y

4. Write your user program

| 5. Startup

The tasks in the user program

The task described in Section 3.1 must now be converted to suitable programmable controller

programs.

supplied with data?
— How are the status bits evaluated?
When completed, you will have
downloaded the user programs to the
stations.

To execute the programs or to download them to the S7 stations...

»~ ...select the container with the program blocks in the
required SIMATIC 400 station in the
PROJECT-ETHERNET.

. Page 34 contains more detailed

— How is the SEND/RECEIVE interface

+ information about the topic

' “Downloading”.

QSIMATIC Manager - [PROJECT-ETHERMET -- D:\Siemens\Step7\Examples\Exie] H=]E3
_18] x|

%Eile Edit Inzert PLC “iew Options ‘Window Help

)=

87| % (sl sl [= 2= (2

=-£59 PROJECT-ETHERMET
E-EJ SIMATIC 400-Station(1)
= [ cru414-101)

-+ CF 4431 BGR[1)
E-l SIMATIC 400-Gtation(2]
B SIMATIC 400-Station(3)

Prezz F1 to get Help.

Suztemdaten

i+

FCE

i+

SFCz2

FC23

=% %2)=| |
i+ it
OB100 FC&
it it
FC30 FCH

The functions of the
blocks are explained in
the following table.

For a better overview...

»~ ...you should print out the program blocks and check them. The following page contains an
overview of the FCs required for communication.

28
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The table shows which blocks of the types OB and FC handle which tasks.

Task in SIMATIC Task in SIMATIC Description of the Task in the Program Blocks
400 Station 1 400 Station 2
Processing process Simulation of a changing process value:
data OB100

Creation of data blocks DB30 and DB31. The process
values are saved in these data blocks.

OB1

Coordination of the program sequence.

FC29

A data word is incremented and decremented cyclically.
The time interval for botj incrementing and decrementing
is 3 seconds.

FC30/FC5 (AG_SEND)

This data word is transferred to Station 2 as the current
process value (job).

Accept and process | Accepting and further processing the job data:

job OB100

Creation of data blocks DB30 and DB31. The process
values are saved in these data blocks.

OB1

Coordination of the program sequence.

FC31/FC6 (AG_RECV)

Save the received data in the data block and output the
data to the process simulation.

FC30/FC5 (AG_SEND)
Return the data to Station 1 as job confirmation.

Evaluate the FC31/FC6 (AG_RECV)
received data Accept and evaluate job confirmation.

Output process data to the simulation module.

Notice

You can take and use the latest versions of the communications blocks (FC5/
FC6) for your module from the SIMATIC NET block library of STEP 7.

If you are using an older module type, this is only possible if you use the latest
firmware version for this module type.

SIMATIC NET NCM S7 for Industrial Ethernet
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The Program Sequence

The organization blocks in the example produce the following program sequence in the two S7
stations:

SIMATIC 400 station 1

\

OB100

— Create data
blocks
DB30 and 31

\

OB1

A v FC29

— Increment /
decrement /
data word

FC30

AG_SEND

FC31

AG_RECV

A LY

Startup

Cyclic
processing

ISO transport
connection

Legend: > Sequence of the CPU cycle

30

SIMATIC 400 station 2

v

OB100

— Create data
blocks
DB30 and 31

\/

OB1

FC31

AG_RECV

FC30

AG_SEND|

SIMATIC NET NCM S7 for Industrial Ethernet
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Programming Functions (FCs) for Communication

Two functions (FCs) are available for handling communication on the

ISO transport connections, as follows:
For more infQrma-

e AG_SEND (FC5) tion... —|
This block transfers the user data from the specified . Manual
user data area to the Ethernet CP for transmission. 131

¢ AG_RECV (FC6) Chapter 4
This block enters the received user data in the user
data area specified in the call. I

The user program in our example was written in STL notation. As an example, the
parameter assignment for calling AG_SEND and AG_RECYV in S7 station 1 is shown below.

STL Expl anati on
call fc 5 /1 AG_SEND bl ock call
ACT 1= M 50.0 //Bit for triggering job
ID = 1 /] Connection I D
LADDR = WE16#0110 /1 Modul e address 272pgc. i n hardware conf.
SEND = P#db30. dbx1.0 byte 240, //Data area to be transferred
LEN = 4 /1 Length of the data area to be sent (4 bytes
DONE = M1.2 /1 Memory bit for return parameter DONE
ERROR = M1.3 /1 Mermory bit for return paranmeter ERROR
STATUS : = MWV 200 /1 Memory word for return parameter STATUS
STL Expl anati on
call fc 6 /1 AG_RECV bl ock call

/1
ID = 1 /I Connection I D
LADDR = WE16#0110 /1 Modul e address 512pgc. i n hardware conf.
RECV = P#DB31. DBX 1.0 BYTE 240 //Data area for receive data
NDR = ML. O /1 Mermory bit for return paranmeter NDR
ERROR = ML. 1 /1 Mermory bit for return paranmeter ERROR
STATUS : = MA202 /1 Memory word for return parameter STATUS
LEN = MALO /1l Area for length of received data

To see the complete code contained in these FCs, and the other OBs and FCs, please refer to
the printouts of the sample project.
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Setting Block Parameters Automatically

To ensure correct parameter settings for the block calls, The LAD/STL/FBD editor in STEP 7
provides you with the option of accepting all the relevant parameters from the hardware
configuration (HW Config) and from the connection configuration automatically. When assigning
the parameter values for the block in the user program, follow the steps outlined below:

~ Select the block call and its block parameters;
»~ Select the menu command “Connections...” with the right mouse button.

»~ Depending on the block type, you can now select the connection intended for the block or
module from a list.

»~ Confirm your selection; as far as possible, the available parameter values are entered in the
block call.

FCs AG_LSEND/ AG_LRECYV for longer data areas (CP 443-1)

The newer versions of the Ethernet CPs with the FCs AG_LSEND (FC50) and AG_LRECV can
transfer larger data areas (up to 8192 bytes). Please check the manual of your CP for the
supported data area and, if applicable, use the appropriate FCs.

Working with the FCs is explained in the manual.

Formore Manual
information... 13/
Chapter 5

SIMATIC NET NCM S7 for Industrial Ethernet
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ns

Extending the Sample Program

You can also extend the sample program or later your own applications. Some possibilities are

shown below:

¢ Evaluation of the result codes of the FCs AG_SEND and AG_RECYV to allow you to react to

specific statuses in your system.

¢ Conditional initiation of communication calls depending on result codes, so that, for examp
the send call on the client is only triggered again after the job confirmation has been
received with the receive call.

»~ Evaluate the parameters DONE, ERROR and For more informa- —
STATUS for AG_SEND and NDR, ERROR and g?tg about status
STATUS for AG_RECV. You evaluate these Manual
parameters as shown below: < 3l
Job Section 4.2

DONE/NDR =1 DONE/NDR =0 DONE/NDR =0

ERROR =0 ERROR =0 ERROR =1

STATUS =0 STATUS = 8180/8181 STATUS = x
Completed without error Active Terminated with error

Typical error codes that must be
handled by the user program:

8302y Lack of resources on partner

8311y Destination station not (yet)
obtainable (e.g. due to startup)

80C3y Resources occupied (due to
maximum load on S7-400)

80D2y Module start address wrong (e.g.
you forgot to change the address

after moving a module)

8304y Connection not yet established

Example without simulation module

If you do not want to use simulation modules, simply deactivate the output “T QW ...” in the
FC31 blocks on Simatic 400 station 1 and 2.

le,

You can then follow the execution of the program by displaying the data blocks online in STEP

7ISTL.

SIMATIC NET NCM S7 for Industrial Ethernet
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To download the user program to the PLC...

...follow the steps outlined below:

» Change the CPU to STOP or RUN-P.

»~ Select the Blocks container in the appropriate station in the SIMATIC Manager.

» Download the entire program (except for the system data) to the S7 station using the PLC»
Download menu command.

" In the RUN-P mode, the block or-
' der is important since the CPU cy- .
' cle is active. Make sure that

. OB100 is only executed during

' startup.

» Change the CPU to RUN-P or RUN. For more informa-

STEP 7 Help System

File Edit Insert BILE
e
Manual
14/

»” Repeat the download procedure for the other station.

Summary of Step 4 “Creating the user program”:

You have now done the following:

— Created user programs according to the task description for both SIMATIC 400 stations
— Extended the sample programs, for example by evaluating the status codes

— Downloaded the user programs to the CPUs of both SIMATIC 400 stations

Result:

If you are working with simulation modules, you should now see the active LED displays on
the simulation modules or output modules indicating that communication is taking place.

If you cannot detect any communication, do one of the following:

» Check the program sequence online in STEP 7/STL (monitor blocks). Check whether a
changing data word is being output to the simulation module.

» Go on to the next step and check communication with NCM Ethernet diagnostics.

SIMATIC NET NCM S7 for Industrial Ethernet
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\ 1. Create your project

Using Ethernet diagnostics,
you can detect
communication problems.

' 3. Configure 1SO transport connections

L~
2. Configure / network your hardware L
1~
V

\ 4. Create the user program

5. Startup / diagnostics

¥ Use, for example, the following diagnostic functions For more infoyma- [
to, check the status of stations and ISO transport tion...
connections. S Manual
13/
Chapter 5
¢ Operating Mode

What is the status of the stations?
* [SO Transport

What is the status of the 1SO transport connections?
Were frames sent?

How many successful?

How many with errors?

¢ Diagnostic Buffer

What do the diagnostic buffer entries say?

SIMATIC NET NCM S7 for Industrial Ethernet
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4 Communication on the SEND/RECEIVE
Interface Between S7 and S5 Stations

In the first example, we showed you the steps involved in configuring
and programming to implement a simple communication task with ISO
transport connections.

In this chapter, we will now show you the (slight) differences that arise if
you want to communicate with a “Non-S7” station. These stations are
generally known as “Other Stations” in STEP 7.

Based on Chapter 1, you will learn the following:

¢ How to handle SIMATIC S5 or “Non-S7 Stations” in the STEP 7
project

¢ How to handle ISO transport connections to SIMATIC S5 or
“Non-S7 Stations”

Requirements:

Working knowledge of STEP 7, knowledge of STL,
experience of working with a PLC, a working knowledge
of SIMATIC S5

Contents:

4.1 Changed system configuration 37

4.2 The example step-by-step 39
— Creating your project 41

— Configuring / networking your hardware 42
— Configuring 1SO transport connections 46
— Creating the user program 49
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4.1 Changed System Configuration

In the system configuration shown in Section 3.2, the S7 station 2 must be replaced by a
SIMATIC S5 station (modifications / alternatives are possible —> see Section 3.2).

SIMATIC 400 station (3) SIMATIC S5
with CP 1430 TF

B f | NCAT o
I B i S
- | -0 I N
M sl o oo N
| )| N L )
MPI interface \
AS511 interface
Ethernet \
- i

T

PG/PC with STEP 7 and STEP 5

SIMATIC NET NCM S7 for Industrial Ethernet
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Required Devices/Resources

You require the following components if you want to use the supplied example unmodified.

No. Type Order Number
Required
1 SIMATIC S7-400 programmable logic controllers see Catalog ST 70
1 CP 443-1 6 GK 7443-1EX11-0XE0 D
1 SIMATIC S5 programmable logic controllers see catalogs ST52.3, ST54.1
1 CP 1430 TF 6 GK1 430-0TAOx
6 GK1 430-0TBOx

1) Newer versions of the module are normally compatible in terms of functionality; You can load
the configuration data of the sample project on your module without needing to make changes.
Please read the information in the manual of the CPs on the topic of compatibility and replacing
devices!

1 Transmission path see [7/, 111/, 112/
1 Programming device (PG/PC) with
e STEP 7 V5.2 and STEP 5 V6.x software or higher
installed

* NCM S7 for Ethernet optional software installed
* NCM COM 1430 TF software installed
* MPI connection

* As an option for the PG/PC mode on Ethernet: CP
for Ethernet connection —>
diagnostics/installation/service

On the S5 station, you can use the example programs supplied with the NCM COM 1430
configuration tool. Depending on the hardware configuration (CPU type etc.), you must select

the suitable sample programs. For more detailed information refer to

P
Manual
114/
Volume 1
Chapter 7
Appendix
A4
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4.2 The Example Step-by-Step

The following example is based on the project that was created and the stations that have been
configured. The steps “Creating your project” and “Configuring/networking your hardware” were
explained in Chapter 2.

| 1. Create your project [
[ 2. Configure and network your hardware V Chapter 2
|
|
|

| 3. Configure FDL connections

[4. Create your user program \ Section 4.2 / and pages following

| 5. Startup

To achieve success quickly...

If you system configuration corresponds to the configuration selected for the example, you can
download the sample data directly to the SIMATIC stations in steps 3 and 4.

You will, however, learn more by working through

the steps as outlined in this primer. JTIP
' Skip the functions that you
. already know.

: Chapter 2 deals with the topic of

SIMATIC NET NCM S7 for Industrial Ethernet
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1. Create your project

\ 2. Configure and network your hardware Extra:

| 3. Configure FDL connections

The S5 station is managed
with NCM COM 1430 TF.

| 4. Create the user program

| 5. Startup — Diagnostics

Managing station 2 (S5):

Use the familiar STEP 5 tools STEP 5 V6.x and NCM COM 1430 TF to edit the programs and
the database file for the sample program for the CP 1430 TF.

Configuration Environment for SIMA-
TIC S5 with CP 1430 TF

Basic Set COM 1430 TF For more information, read:
i ] P e——
tings - I
Database file: - /ﬁsua
ABU1AG2.CP2
Volume 1
Chapter 7.
Appendix A.4

Summary of Step 1 "Creating your Project”:

You have created a project in STEP 7 in which you can configure your SIMATIC
400 station and save the corresponding user programs.

You have created a database file for the S5 station in which the CP configuration
data can be saved.

SIMATIC NET NCM S7 for Industrial Ethernet
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| 1. Create your project e

Extra:
— The SIMATIC S5 station must be
made known in the STEP 7 project
and networked.

2. Configure / network your hardware

| 3. Configure ISO transport connections

| 4. Create the user program \

| 5. Startup \

To configure the SIMATIC 400 station in the STEP 7 project...

...follow the procedure described in Chapter 2.

Managing the S5 Station

For information about managing the configuration data and the
(sample) programs, please refer to ......

This provides you with information about handling the S5 tools. < N}ilz;lal
Volume 1
Chapter 5
Appendix
A4

To network the SIMATIC 400 station with the SIMATIC S5 station and
to be able to obtain the station on ISO transport connections...

...this “S5 station” must be included in the STEP 7 project. In the sample project, a station of
the type “SIMATIC S5” has been created.

QSIMATIC Manager - [PROJECT-ETHERMET -- D:\Siemens\Step7\Examples\Exie]

%Eile Edit Inzert PLC “iew Options ‘Window Help

Cil 825 [ =[] sl [= = 2. =

[ Ho Fiter > =1¥| 38ls

ER=] oL 1 7 7 :
= SIMATIC 400-5tation(1) = = il
SIMATIC 400-Station(2] SIMATIC SIMATIC SIMATIC SIMATIC 55(1)
EHEl SIMATIC 400-tation(3)] 400-5tatian(1) 400-5tation(2] 400-Station(3)
SIMATIC 55(2) MPL-Netz(1] Etherriet [1)

Prezz F1 to get Help. | | |

If you want to continue working in a different project, you must now create a “SIMATIC S5
station”.

»~ Select your project.

V¥ Select the Insert » Hardware »SIMATIC S5 menu command.

SIMATIC NET NCM S7 for Industrial Ethernet
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...Now network the station

Networking the SIMATIC 400 station is also the same as in the first example. The main point of
interest here is how to network the SIMATIC S5 station:

4. Select the SIMATIC S5 station that you want to @
check in your project using the SIMATIC Manager
or the NetPro view. SIMATIC 55(1)

5. Select the Object Properties dialog with the menu Edit »Object Properties or by
double-clicking the icon.

Properties -SIMATIC 55 [ %]

General [nterfaces |

» To check which MAC P YE———

42

Mame | Type | Address | Subnet |
Ethermet Teilnehmer (1] Ethernet interface 140.80.01 Ethernet (1]

Properties - Ethernet interface [ %]

General Parameters |

MAC Address: 03.00.06.01.00.02

Flaperties,..

Subnet:

Hew...

address is used to

access the SIMATIC | Properties... |
S5 station, select the Delete |

“Ethernet node (1)” and
click the “Properties”
button.
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Downloading the hardware configuration to the PLC

To download the configuration data to the SIMATIC 400 station, follow the steps outlined below

¢ For the SIMATIC 400 station, as described in Chapter 2.

e For the SIMATIC S5 station, as described in...  ——

Manual
114/

Chapter 6

Summary of Step 2 ” Configuring and Networking Your Hardware”:

You have now done the following:

1.
2.
3.
4,

Configured the SIMATIC 400 station in the STEP 7 project

Assigned the SIMATIC 400 station to the Ethernet and assigned addresses
Downloaded the configuration to the SIMATIC 400 station

Adapted the network configuration of the SIMATIC S5 station with NCM COM 1430 TF.

The SIMATIC 400 station is now ready for you to configure communication connections
and download user programs.

SIMATIC NET NCM S7 for Industrial Ethernet
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| 1. Create your project L~
| 2. Configure / network your hardware V-

3. Configure ISO transport connections

Extra:

— The connection parameters
for the S5 and S7 PLCs must
be matched.

| 4. Create the user program \

| 5. Startup \

To create the ISO transport connections for S7-Station(3) in the STEP 7 project...
...follow the steps as described in Chapter 1:
¢ Display and check the configured connections in the connection table.

¢ Download the configured connections to the PLC.

Checking/configuring connection parameters

In the Addresses tab page, adapt the TSAP setting so that it matches the configuration in
S5-Station. Only then can the local endpoints of the connection be correctly identified so that a
connection can be established successfully.

Follow the steps below:
» Open the connection table for the CPU in the SIMATIC 400 station.

»~ Select the connection properties by double-clicking the connection in the connection table.

Properties - 150 tranzport connection E
Optionz I Overview | Status [nformation I
General | Addresses I Dynamics
— Connection Endpaint  Block Parameters
Local ID [hex): 0007 A020
Mame: IlSD-‘J’elhindungJ 1—ID

viaCP:  |CF 443-1150 - [RO0/S4) Wi1EH0200 —|LADDR

Boute... |

V¥ active connection establishment

Cancel Help

¥ Check the “Active Connection Establishment” box. This must be selected.

SIMATIC NET NCM S7 for Industrial Ethernet
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» Change to the “Addresses” tab page.
»” Check the TSAP entries and if necessary adapt them to the configuration for the S5 station.

To check and adapt the ISO transport connections for the SIMATIC S5 station,
»” Use the function “Edit »Connections>Transport Connections” in COM 1420 TF:

}” Check the following assignment: - '\//'lir}”m
TSAP local (S5) = TSAP remote (S7) Volume 1
TSAP remote (S5) = TSAP local (S7)

Chapter 7

COM 1430 TF
Transport Connection

Local Parameters: Remote Parames
I8 Address: 08.00.08:
TSAP (ASC): 01 TSAP (ASC): 02

TSAP (Hex): 20.20.20.20.30.20.20.32. TSAP (Hex): 20.20.20.20.30.20.20.

Properties - IS0 transport conn=ction

Options Osfrview | Status Information
General Addreszes Diynamics
Local Remote
MALC [HEX): [08.00.06.07.00.00 IDS.DD.DB.DﬂQD.D‘I
TSaP [ASCI): IISD-1
TSAP [HEX) |49.53.4F.2D.31 |49.53.4F.2D.31
TSAP length: 5 5

Cancel Help
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Downloading the connection configuration to the PLC

To download the configuration data to the stations, follow the steps outlined below:
¢ For the SIMATIC 400 station, as described in Section 1.3.

¢ For the SIMATIC S5 station, as described in...

Manual
114/
Volume 1

Section 6.4

Summary of Step 3 — “Configuring ISO transport connections”:
You have now done the following:

1. Configured an ISO transport connection between the SIMATIC 400 station and the
SIMATIC S5 station

2. Downloaded the connection configuration to both stations

The stations are now ready for data exchange on the SEND/RECEIVE interface.
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| 1. Create your project

\ 2. Configure / network your hardware
Extra:

AR Y

| 3. Configure 1SO transport connections

— OBs, FBs and HDBs are used

4. Create the user program on the SIMATIC S5 side.

| 5. Startup \

The tasks in the user program

Compared with the description of the task in Chapter 1, the sample must be adapted for the CP
1430 TF according the description in /14/, as follows:

Data are only sent by the SIMATIC 400 station to the SIMATIC S5 station, they are not
returned so that the send call in the SIMATIC S5 station and the receive call in the SIMATIC
400 station are omitted.

The table shows you which blocks of the type OB and FB in the SIMATIC S5 station are
responsible for receiving the job data from the SIMATIC 400 station and processing it.

Task in the SIMATIC | Task in the SIMATIC Description of the task in program blocks
400 Station S5 Station

Processing process Simulation of a changing process value:

data OB100

Creation of data blocks DB30 and DB31. The process
values are saved in these data blocks.

OB1

Co-ordination of the program sequence.

FC29

A data word is incremented and decremented cyclically.
The time interval for both incrementing and decrementing
is 3 seconds.

FC30/ FC5 (AG_SEND)

This data word is transferred to Station 2 as the current
process value (job).

Receive and process | Receiving and processing job data:

job OB1

Coordination of the program sequence.

FB101 (HDB RECEIVE)

Saves received data in the data block and outputs them
to the process simulation.

Notice

You can take and use the latest versions of the communications blocks (FC5/
FC6) for your module from the SIMATIC NET block library of STEP 7.

If you are using an older module type, this is only possible if you use the latest
firmware version for this module type.
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The Program Sequence

In the example, the OB blocks organize the following program sequence in the two stations:

SIMATIC 400 SIMATIC S5 station
station
v OB 20/21/22 v
OB 100 FB 111
— Create Startup HDB-SYNC
data blocks
DB30 and 31 v
Cyclic
B 1 processing 0B 1
‘ ' FC 29 A
— Increment /
decrement
dat d
At wor FB 101 \/
| [
FC 30 HDB-CTRL
AG_SEND 180 — | | HDB—RECEIVE
transport
— connection -

Legend: > Sequence of the CPU cycle

To process or download the programs of the SIMATIC 400 station...

...follow the steps described in Chapter 1. The information in Chapter 1 about the program
extensions, for example to evaluate the call status codes, also applies here.

For the SIMATIC S5 station ...
...you should adapt the program to obtain the required sequence, as follows:

»~ If the CP 1430 TF is not synchronized during startup, this may be caused by an incorrect
OB20. Copy the content of OB21 to OB20 so that the HDB SYNC is correctly called.
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Notice

Make sure that you use the correct HDBs for the specific CPU in the S5 station.
In the example, you require the following:

HDB-SYNC

HDB-CTRL

HDB-RECEIVE

Summary of step 4 “Creating the user program”:

You have now done the following:

1. Created user programs according to the task for both stations

2. Extended the sample programs, for example to include evaluation of status codes
3. Downloaded the user programs to the CPUs of both stations.

Result:

To monitor the data transfer, follow the instructions in the manual of the CP 1430 TF. You
monitor the updating of the data in the receive data block on the SIMATIC S5 station.

P
Manual
114/
Volume 1

Appendix A

If you cannot detect any communication, do one of the following:

» Check the program sequence online in STEP 7/STL (monitor blocks). Follow the same
procedure with the programs on the SIMATIC S5 PLC in STEP 5.

»* Check communication with Ethernet diagnostics, as shown in Chapter 1.

4
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References

Manual/ Product Information SIMATIC NET CP
Supplied with each CP
SIEMENS AG

NCM S7 for PROFIBUS Manual
Supplied with the documentation package NCM S7 for PROFIBUS
SIEMENS AG

NCM S7 for Industrial Ethernet Manual

Supplied with the documentation package NCM S7 for Industrial
Ethernet

SIEMENS AG

SIMATIC STEP 7 User Manual
Part of the standard STEP 7 Documentation Package
SIEMENS AG

SIMATIC STEP 7 Programming Manual
Part of the standard STEP 7 Documentation Package
SIEMENS AG

SIMATIC STEP 7 Reference Manual
SIEMENS AG

Industrial Twisted Pair Networks
SIEMENS AG

Ethernet, IEEE 802.3
(ISO 8802-3)

SINEC CP 1413
Manuals for MS-DOS, Windows
SIEMENS AG

SIMATIC S7

S7-300 Programmable Controller
Hardware and Installation
Manual

SIEMENS AG
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111/

112/

113/

114/

Order Numbers

SINEC H1 Manual for Triaxial Networks SINEC H1
SIEMENS AG

SINEC H1FO Ethernet Manual
SIEMENS AG

SIMATIC Software

NetPro

Graphic Network Configuration
SIEMENS AG

SINEC

CP 1430 TF with NCM COM 1430 TF
Manual

SIEMENS AG

6 GK 1970-1TA43-0AA0

The order numbers for the SIEMENS documentation listed above can
be found in the catalogs “SIMATIC NET Industrial Communication,
Catalog 1IK10” and “SIMATIC Programmable Controllers SIMATIC S7 /

M7/ C7".

You can obtain these catalogs and any further information you require

from your local SIEMENS office or national head office.
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